
PLEASE READ CAREFULLY BEFORE USING THIS COMPUTER SOFTWARE. 

The right to use this software is sold on the condition that the purchaser agrees to abide by 
the terms of the licence as set out below.  Should the purchaser not agree to these terms, all 
items supplied, including the computer media, the User Guide and the software protection 
device should be returned immediately in an unused condition.  Upon such return the full 
licence fee will be refunded.  Failure to return these items promptly will indicate the 
purchaser’s acceptance of this licence agreement. 
 

LICENCE AGREEMENT 

In return for the payment of the agreed fee, the purchaser is granted a licence by Lihou 
Technical and Software Services to use the HAZOP Manager computer program and 
ancillary software.  This licence will remain in effect in perpetuity, unless automatically 
terminated by the failure of the purchaser to comply with any term or condition of this 
agreement.  The purchaser agrees upon such termination to return immediately all items 
supplied under this agreement, and to destroy all copies of the software. 

The purchase of this licence does not transfer any right, title or interest in this software 
product except as specifically mentioned in this agreement.  The purchaser agrees that the 
software is protected by copyright law, and further agrees to take all reasonable steps to 
prevent its unauthorised use, copying or dissemination. 

Multiple usage of the program is protected against by means of the security device supplied.  
The purchaser is permitted to install the software on as many machines as is necessary, with 
the security device preventing more than one such installation from being operational at any 
time.  The purchaser agrees that no attempt will be made to circumvent this protection, either 
by disassembly or program modification, or running the software under any system 
configuration that would allow multiple usage. 

The purchaser agrees that this licence will also apply to any modifications, updates or 
enhancements to the software which may be supplied either free of charge or in return for 
the payment of an additional licence fee. 

Lihou Technical and Software Services warrants that the software will operate substantially 
in accordance with the accompanying documentation, both printed and in the form of online 
help and operating guidelines.  No other warranty is given, either expressed or implied, 
including but not limited to the implied warranty of fitness for a particular purpose. 

Should the purchaser discover a defect in the software, Lihou Technical and Software 
Services will make every reasonable effort to rectify the problem and supply the purchaser 
with an amended program.  Only in the event that such efforts fail, the purchaser may return 
all items supplied and obtain a full refund of the licence fee paid.  The purchaser agrees that 
this is the sole remedy, and that Lihou Technical and Software Services, as well as its 
employees or agents, will not be liable for any damages, including lost profits or incidental 
or consequential damages, arising either out of the use or inability to use the software. 

The software is designed to operate upon current, as at the date of purchase, Microsoft 
Windows operating systems as specified in the installation instructions.  It shall not be 
construed that the software is defective if it should fail to operate upon past or future 
releases of such operating systems. 
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GUIDELINES FOR INSTALLING 
THE HAZOP Manager V6.0 SOFTWARE 

 
 
SYSTEM REQUIREMENTS 
• The operating system should be Windows 95/98/ME, or Windows 

NT 4.0/2000/XP/Vista. 
• The target computer should have a 133 MHz or higher Pentium- 

compatible processor, with a 256 colour or greater display 
capability, and at least an SVGA (800 x 600) screen resolution. 

• The minimum memory requirements recommended by Microsoft for 
each operating platform listed above will be adequate. 

• For a stand-alone installation a minimum of 10MB of free disk 
space should be available. 

 
 
GENERAL REQUIREMENTS 
• Windows NT, 2000, XP or Vista - The installation of the program 

will involve adding driver files to your Windows system, and 
updating the Windows Registry accordingly.  In addition, the 
software will be installed in the Common Programs Group, thus 
making it available to all users of the target computer. 
The security features implemented within Windows NT, 2000, XP 
and Vista do not allow ordinary users to undertake such operations.  
For this reason, any attempt to run the installation program by 
a user who is not logged on with full System Administrator 
privileges will be blocked.  Similarly, if later the program needs to 
be ‘Repaired’, ‘Modified’ or ‘Removed’, a System Administrator 
must also undertake this task. 

• Local vs. Remote Installation - As part of the installation 
procedure the Windows Registry will be automatically updated as 
mentioned above.  The Setup program will update these files for the 
computer on which it is currently being run.  Problems may arise, 
therefore, if a Network Administrator, sitting at a remote computer, 
attempts to use the setup procedure as a vehicle for just transferring 
files to a directory on a workstation.  The possibility then exists that 
the system files on that workstation will not be correctly updated, 
and the HAZOP Manager program will not run.  With this in mind, 



it might be better to undertake installations whilst sitting in front of 
the target machine. 

• Read-only Windows Directories - During the installation, the 
Setup program will need to copy certain files to the target 
computer’s Windows System directory.  In some companies, the 
System directory is made ‘read only’ to prevent users from altering 
settings or deleting, adding or amending files or software.  If your 
Windows installation is configured in this manner, then do not 
proceed with any attempt to install the HAZOP Manager software, 
as the Setup program will most definitely fail to complete the 
installation satisfactorily. 
If your Windows System directory is locked as explained above, 
you will need to temporarily remove that lock whilst installing the 
software.  Such a lock can then be re-instated after completing the 
procedure. 

 
 
INSTALLING THE SOFTWARE 
Place the installation CD in your CD-ROM drive… a menu of installation 
options as illustrated below should be displayed within approximately 15-
20 seconds.  If this auto-run facility fails, or is disabled on your computer, 
refer to the CD label for instructions. 

 

 



As shown in the illustration on the previous page, there are three options 
relating to the installation of the software: 
• HAZOP Manager V6.0 - Pressing this button will launch the setup 

routine for the program’s installation.  This option must, of course, 
be selected for all installations. 

• DESkey DK2 Drivers - The software is protected by a DESkey 
Parallel Port, USB or PCMCIA security device (dongle).  Pressing 
this button will launch the setup routine for installing the necessary 
drivers and DLLs on the target computer.  This option must be 
selected for all installations. 

• DESkey Network Server Drivers - As mentioned above, the 
program is protected by a DESkey DK2 device.  In most 
circumstances, this would be plugged directly into the computer 
currently running the HAZOP Manager program.  It is possible, 
however, to have a DK2 encoded with multiple program licences, 
such that a single device will permit the simultaneous running of 
multiple copies of the software (up to the licence count).  In this 
case, the DK2 will need to be plugged into a network server 
accessible to all workstations on which both the program and the 
basic DESkey DK2 drivers in the options above have been installed.  
Pressing this button will launch the setup routine for installing the 
necessary licence management software and drivers on the chosen 
network server.  This option need only be selected in the 
circumstances described, and it would essentially be a separate 
procedure to that carried out for the first two choices above. 

For the sake of clarity, the procedures and decisions involved in each of 
the above three options will be described separately in the sections that 
follow. 
 
 
INSTALLING HAZOP Manager V6.0 
After the first familiar ‘Welcome’ screen, the ‘Installation Options’ 
window illustrated on the following page will be displayed.  It is 
important to note that the entries in that window regarding ‘Network 
Server’ and ‘Workstation’ are not related in any way to the explanations 
given above about the location of the DESkey device and its drivers.  
Rather, these installation options refer to the location of program files, 
and whether you wish them all to be installed on the target computer, or 
alternatively have them split for administrative purposes between a 
network server and a workstation. 

 



 
 
Installation Options 
The recommended course of action when installing the software is to 
create a ‘stand-alone’ installation, with all files residing in a read/write 
directory on the target computer.  This is the ‘Full Installation’ option in 
the dialog illustrated above.  For each ‘Full Installation’ you will need to 
subsequently install the DESkey DK2 Drivers on the computer 
concerned. 

The Setup routine does, however, have the facility to install certain 
program files (executables and dynamic link libraries) to a network 
server, such that future updates to such files would only need to be 
carried out in one location.  This is the ‘Network Server’ option in the 
above dialog.  The basic DESkey DK2 Drivers should not be installed on 
this server.  

A Network Server installation must be followed by one or more 
‘Workstation’ installations.  These will create registry entries and 
shortcut icons, and copy user files, to each workstation on which the 
HAZOP Manager program will be used.  Following each ‘Workstation’ 
installation, you will need to install the DESkey DK2 drivers on that 
workstation. 

If you choose the Full Installation, you will subsequently be given the 
option to install certain program files in a read-only folder, and other user 
files in a folder with full read-write permissions.  This is discussed in the 
section that follows. 

 



Choosing the location of User Files 
The program utilises and creates many files that are editable, and which 
in most circumstances must be accessible to all users of the software.  
These are, for example, Data files, Keywords, Resources, Headings, 
Macros, Causes and Failure Rate databases, etc. (hereafter referred to as 
‘User Files’).  It is important that these User Files are stored in a location 
that has read/write permission for all persons who will be running the 
program on the target computer.  In other words, they should not be 
located in one individual’s personal ‘My Documents’ folder unless it can 
be guaranteed that no one else will need access to his or her data files.  
When performing a ‘Workstation’ installation, this is the main 
consideration.  However, as mentioned in the previous section, even 
when performing a ‘Full Installation’ it is sometimes deemed necessary 
for the program files (executables and DLLs) to be located in a read only 
folder on the target computer to prevent inadvertent modification or even 
deletion.  The Setup program will enquire whether the main program 
directory will be read-only, and if that is the case, request that another 
location be specified for User files.  It is important that you take heed of 
this enquiry and request… the most common reason for subsequent 
problems in running the HAZOP Manager software are User Files 
incorrectly located in read-only directories. 
 
 

INSTALLING THE DESkey DK2 DRIVERS 
Important – If your DESkey is a USB or PCMCIA device, you should 
not plug it into the target computer until these drivers have been loaded 
(this may require a re-boot of the computer).  Failure to follow this 
sequence is likely to result in your Windows operating System loading its 
own inappropriate drivers, and if that occurs you will be unable to run the 
HAZOP Manager software.  Note that, after installing the drivers, if a 
‘Found New Hardware Wizard’ is displayed on the first occasion that the 
device is plugged into the computer, you should allow Windows to 
‘Install the software automatically (Recommended)’.  It will not be 
necessary to re-insert the installation CD-ROM. 
After the first familiar Welcome screen, you will be asked to specify 
where the DESkey will be located.  The options are: 
• This machine 
• A machine on the network using a DK2 Network Server 
If you select ‘This machine’, then the installation will proceed to 
completion without any further intervention on your part. 

 



If you select ‘A machine on the network etc...’, then a further ‘Network 
Configuration’ dialog will be displayed in which you will be required to 
name the server to which the DESkey will be fitted, and on which the 
required server software is, or will be, installed.  Press the ‘Add’ button, 
which will display a further small dialog, then on this latter dialog press 
the ‘Browse’ button to select from a list of servers as illustrated below. 

 

Having selected the network server, the installation will proceed to 
completion without further intervention on your part.  Note that at a later 
date you may change to another server by invoking the DESkey Applet 
within Control Panel, and then following essentially the same procedure 
as described above. 
 
 
INSTALLING THE DESkey NETWORK SERVER DRIVERS 
Firstly, it is recommended that you do not plug the DESkey into the 
server until prompted to do so after the software has been installed.  This 
is especially important for USB or PCMCIA devices. 
Following the first Welcome screen, the next dialog displayed will ask 
you to specify the directory (folder) on the server in which the driver and 
licence management software should be located.  You may either accept 
the default presented, or alternatively press the ‘Browse’ button to select 
another folder. 
After the software has been installed you will be asked whether you wish 
the service to be started immediately.  For a Parallel Port or USB DESkey 
you may plug the device into the machine and press the ‘Yes’ button.  For 
a PCMCIA device you will need to press ‘No’, and then reboot the 
server. 

 



Further information regarding the management of a network server 
installation can be found in the ‘DNSrv32V5.pdf’ file, which is located in 
the \DESkey sub-folder on the program’s installation CD-ROM.  The 
default password to access the functionality of the ‘Network Server 
Remote Monitor’ utility is mentioned on Page 5 of that document.  This 
password should be changed as soon as possible, as all users of the 
HAZOP Manager program will be able to access this utility on their 
workstations.  This allows them to check who is currently using the 
software, but it would be undesirable if they could also then use that 
default password to, for example, abruptly terminate another person’s use 
of the program. 
 
 
RUNNING THE HAZOP Manager PROGRAM 
The software is protected by means of a DESkey DK2 security device.  
You should ensure that the DESkey software has been installed and that 
the device is fitted to the appropriate port before attempting to run the 
program (see the DESkey section on page 10 of this guide).  Then click 
on the Start button on your taskbar, highlight the Programs folder, open 
(highlight) the HAZOP Manager V6.0 sub-folder, and then click on the 
‘HAZOP Manager V6.0 Program’ entry. 
On the first occasion the software is run it will register the Hazop Data 
File extension (*.hdf) with the Windows system.  Thereafter, you may 
also double click on a data file within Windows Explorer to launch the 
program. 
 
 
REPAIRING, MODIFYING OR REMOVING THE PROGRAM 
During the setup of the HAZOP Manager program, a ‘Change/Remove’ 
facility will have been registered within the Add/Remove Programs icon 
in the Control Panel.  Such a facility will provide an easy method of 
repairing, modifying or removing the program. 
You may choose to ‘Repair’ the program if, for instance, certain files or 
Registry entries required by the software have been inadvertently deleted. 
The only modification that can be made to the installation is the addition 
of further dictionaries for the purpose of spell checking in different 
languages. 

 



The ‘Remove’ option should only be selected when the entire application 
is no longer required on the computer concerned. 
The following points should be borne in mind: 
• If your computer is running Windows NT, 2000, XP or Vista, the 

repair / modification / removal of the program can only be 
accomplished by a System Administrator. 

• Data files created by you will not be deleted, nor will any other user 
files created by the software during the normal course of its 
operation. 

• The DESkey drivers will not be automatically uninstalled in case 
other software on your computer requires a similar device.  This will 
preclude the possibility of such other software suddenly and 
inexplicably failing to function.  However, should you wish to 
remove these drivers because you are certain that they are no longer 
required, use the separate entry in Control Panel’s Add/Remove 
Programs list entitled ‘DK2 DESkey Drivers’.  As mentioned above, 
a System Administrator will need to accomplish this task. 

 



THE ‘DESkey’ SOFTWARE PROTECTION DEVICE 
 
 
Before running the HAZOP Manager program you should ensure that the 
DESkey software is installed (see the section on DESkey DK2 Driver 
installation on Page 6) and that the device is fitted to the appropriate 
hardware port. 
When starting the program two messages will be very briefly displayed… 
‘Checking Security’ followed by ‘Loading Application’.  Providing the 
conditions described in the above paragraph are fulfilled, the program’s 
main window should then be opened.  In the very unlikely event that a 
problem occurs during this phase of program loading, one of the 
following error messages will be displayed: 
• DESkey not found.  Insert DESkey and restart program.  This 

indicates that the security software cannot locate the DESkey.  Bear 
in mind that if using a parallel port device, it is possible on some 
computers to fit the device the wrong way round to the serial port.  
Note the arrows that indicate which end should be plugged into your 
computer.  Also with such a device, if a printer is attached to the 
DESkey, it is important that the printer is switched on.  Otherwise, 
electrical power will be drained from the device, causing it to return 
weak or corrupted data when interrogated by the program. 
Another potential reason for this message to be displayed is that 
your DESkey Driver software is not compatible with your Windows 
operating system.  This could be the case if, having successfully run 
the program in the past, you have now upgraded to a new version of 
Windows.  If this appears to be the cause of the problem, you will 
need to contact LTSS for technical assistance. 
The final reason for this error to occur is either a malfunctioning 
computer port or a damaged DESkey.  Try running the program, 
using the same device, on another computer.  If the same problem 
still occurs, contact LTSS. 

• DESkey Device Driver not found.  Install and restart program.  
Note the different wording to the message above.  This indicates that 
either the required driver software (see Page 6) has not been 
installed, or the installation of this software has failed.  If the latter, 
you should contact LTSS for technical assistance. 

 



• Decryption failed. Please check your DESkey.  This could 
indicate either a malfunctioning device, or a problem with the driver 
installation.  Try un-installing and then re-installing the DESkey 
drivers, and if the problem persists, contact LTSS. 

• You do not have authorisation to run this program.  This almost 
certainly indicates that you are attempting to run the program with a 
DESkey supplied with a previous version of the HAZOP Manager 
software.  You will need to either update the device with the utility 
software provided for this purpose, or alternatively contact LTSS to 
order a program upgrade. 

• No Servers could be found.  This message will only be displayed if 
your DESkey driver installation has been configured to access a 
multi-user device located remotely on a network server.  Almost 
invariably this will indicate that all program licences are currently in 
use.  However, if this is not the case, either your installation has 
been set up with incorrect server information, the server software 
has not been installed, or the device has been removed from the 
server.  Contact your IT Department for assistance. 

Note that if the DESkey is removed whilst running the software, the 
program will display a message asking whether you wish to refit the 
device.  You should always replace the DESkey.  If you respond in the 
negative, the program will be abruptly terminated and you will run the 
risk of damaging your data files. 
When using a parallel port DESkey a similar situation can arise if, in the 
middle of running the program with a printer connected to your computer 
and switched on, you turn that printer off without first disconnecting it.  
Because this may cause the device to respond incorrectly for the reasons 
described on the previous page, the program will believe that it has been 
removed. 

VERY IMPORTANT (Parallel Port DESKeys only) - The instruction 
manuals included with earlier models of the Iomega ZIP Parallel Port 
Disk Drive stated that dongles (DESkeys) could safely be used with these 
drives.  Later Iomega instruction manuals now caution against such use.  
If using a parallel port ZIP Drive (or a similar drive marketed by another 
manufacturer), it is strongly recommended that the DESkey is fitted to a 
separate port (i.e. LPT2), or the drive is temporarily removed whilst 
running the HAZOP Manager program.  Failure to do this could result 
in severe damage to the DESkey’s electronic components. 

 



THE ACTION RESPONSE UTILITY PROGRAM 
 
 
In addition to the HAZOP Manager program files, an executable file 
named ACTRSP.EXE will have been installed on your computer (or 
network server).  You will also note that an icon will have been created in 
the HAZOP Manager V6.0 program folder that will allow you to run this 
utility. 
If actions are to be distributed by e-mail or on diskette, you will need to 
include this utility program with the Action Files.  It would be utilised by 
recipients to type their responses, and then subsequently to create 
Response Files.  These latter files would be returned to the Study 
Secretary, who would use them to automatically update the main study 
file. 
If desired, the Study Leader or Secretary may use this utility to open and 
scan (but not alter) the contents of the returned Response Files before 
they are read into the main study data file.  However, the icon is also 
provided so that those persons may familiarise themselves with this utility 
program’s operation before despatching it to third parties.  They will then 
be in a better position to advise and guide the recipients of Action Files as 
to how best to use this facility to generate their responses. 
To assist in this process of familiarisation, a data file named 
ACTRSP.HDF, together with an Action File entitled ‘D Matthews_1.act’, 
will have been installed in the \DATA subdirectory.  A brief description 
of the purpose and content of these files, and the procedure to follow 
when experimenting with this facility, is given in the ‘Other Details’ 
section of ACTRSP.HDF.  Opening that file in the normal manner, and 
reading the above-mentioned section, should give sufficient guidance as 
to how to proceed.  Tutorial 9 also shows how this utility may be used.  
However, if questions arise that are not covered either in the HAZOP 
Manager or ACTRSP programs’ Help files, please contact us.  We would 
be happy to discuss any point that requires clarification. 
As mentioned above, Tutorial 9 within this User Guide explains the 
procedures for creating Action Files, Response Files, and automatically 
updating the main study data file. 
 

 



OPERATING GUIDELINES - The Help System 
 
 
The operating instructions for the HAZOP Manager program are 
contained in the on-line Help system.  For those who are accustomed to 
having a printed manual, such a statement might induce a sense of 
unease.  However, you should reserve judgement until you get acquainted 
with the Windows Help engine, which in many ways is far superior to 
having to refer to printed documentation. 
The following sections will explain how you can easily become familiar 
with the operation of the HAZOP Manager software by using that Help 
system, and hopefully by the end of this exercise you will feel much more 
comfortable with the lack of a printed manual. 
Before we commence this exploratory exercise, you should start the 
HAZOP Manager program and wait until the main window is displayed. 
 
Exploring the Help System - The Table of Contents 
1. Begin by selecting the Help menu, and the Help Topics option.  The 

window displayed will show the Table of Contents along with the 
first topic.  Each entry in the left-hand pane represents a chapter.  
Open the third and fourth chapters entitled “How to use the HAZOP 
Manager program” and “Program defaults and resources” by 
clicking the plus sign next to their book icons. 

 

 



2. Note that each of these chapters is subdivided into pages.  Click on 
“Preparing for a Hazop Study”.  The selected topic will appear in 
the right-hand pane.  Take your time to scan the text displayed.  
There is no need to study these guidelines in detail… at the present 
time we are getting to know the Help system, rather than learning 
how to use the program. 

3. In the Help window you will notice a section heading “Create a 
Study Data File”.  Click on the green underlined text ‘create a new 
data file’, and immediately we go to another page in the manual, 
which explains how this is done. 

4. At the bottom of the text on that page is a heading “Data File 
Options”.  Click on the green underlined text ‘Setting Data File 
Options’ to display an explanation of this procedure. 

5. Suppose that we wish to continue our exploratory browsing, but this 
subject of file options interests us, and we might want to return to it 
later.  Set a bookmark by using the Bookmark menu option.  The 
sequence is menu option Bookmark - Define - OK. 

6. Now we want to get back to our original subject of “Preparing for a 
Hazop Study”.  We may do this in two ways.  Either press the Back 
button twice, or click on the “Preparing for a HAZOP Study” in the 
Contents pane. 

7. Let us now immediately use our bookmark.  Select Bookmark - 1 
Setting Data File Options, and we are back on that topic.  Assuming 
we no longer need to refer to this again, select Bookmark - Define, 
highlight the relevant entry, and press Delete. 

8. In the left hand pane, you will notice that the chapter entitled “Study 
Data Files” contains three sub-chapters.  Open all three so that each 
individual page is listed. 

9. In the third sub-chapter is a page entitled ‘The sections of a Data 
File’.  Go to this page and scan through it.  It will give you a good 
appreciation of how a data file is represented on screen, and the 
toolbar buttons used to move through the file. 

10. If you wish you may explore further through the Help system, 
opening further chapters, using the green underlined hypertext links, 
and the Back button. 

 



11. When you have finished exploring in this manner, and assuming that 
a Help topic is currently displayed, select the Options menu and the 
Display History Window command.  Every page you have visited 
will be listed, and you need only double click on any one of them to 
jump again to that page. 

 
Exploring the Help System - The Index 
1. If necessary, open the Help system again, then press the Index tab. 
2. Earlier in this User Guide, you may remember reading a reference to 

Action Files.  You wish to find out more about these without having 
to search through every page in the Contents tab. 

3. Type ‘Action Fi’, and the index will scroll automatically to the 
appropriate section.  When you click on the ‘Action Files’ topic a 
popup window will indicate that there are two pages concerned with 
this subject.  You may wish to open them both to scan their 
contents. 

 

4. Type ‘Word’ in the edit box at the top of the Index.  Notice that the 
topic ‘Word-Microsoft … Action Documents’ is scrolled into view, 
illustrating that you can find an individual topic using different 
keywords. 

 



Exploring the Help System - The Find facility 
1. If necessary, open the Help system again, then press the Contents 

tab. 
2. Open the chapter “Worksheet Entry operations”, and go to the page 

‘Worksheet Entry Form’. 
3. Note that in the illustration on that page there is an empty box 

entitled ‘[REF]’.  A brief explanation of that entry point is given 
below the illustration, but let us assume that we fail to notice that 
explanation.  Because the significance of this entry point is not 
clear, we wish to find out more about it. 

4. Click on the Search tab. 
5. On the very first occasion you do this, the Windows Help engine 

will need to create a database.  Choose the recommended option of 
‘Minimise database size’, and press Finish.  

 

6. Now type ‘REF’ in the edit box (in upper case, as illustrated above).  
The names of four topics will be displayed.  Double click on the 
‘Multiple Actions’ topic.  The topic displayed explains the 
significance of the ‘REF’ entry point on the Worksheet Entry form. 

7. Try another experiment.  You want to know more about Hazop 
Keywords, and it is a good bet that in a topic covering that subject 
the word ‘Flow’ will be mentioned.  Therefore in the Search tab edit 
box type that word (i.e. Flow). 

 



8. The list of topic pages displayed all contain the word ‘Flow’, and 
amongst them will be the subject that you are interested in, namely 
the ‘Keywords Form’. 

9. Note that another page listed is ‘Defining relevant Keyword 
combinations’.  Open (double click) that as well to learn more about 
how this feature may help when applying keywords in a study 
meeting. 

 
 
Exploring the Help System - Summary 
So far we have been using the Help system much as one would refer to a 
printed manual, and the increase in flexibility and speed we hope is 
obvious.  The statement made at the beginning of this section, expressing 
our conviction that you will feel comfortable about the lack of printed 
instructions, we hope has been justified. 
If time permits, you should at least open each chapter in the Contents tab, 
making a mental note of the page headings.  It would be very tedious to 
fully read each individual page, but by scanning only the topic headings 
you will obtain a basic appreciation of the facilities that are available 
within the program.  Later, when you wish to undertake some seldom 
used procedure such as copying an entire entry, you will know that there 
is a quick way to achieve this because you will remember seeing some 
time ago a topic heading dealing with that subject.  You can then use the 
features of the Help system to obtain a full explanation of how this 
operation can be accomplished. 
In addition to the methods explored above, there is also of course context 
sensitive help.  Highlight a menu option, and whilst keeping it 
highlighted, press F1 (don’t release the mouse button, or the command 
itself will be activated).  This will display a full explanation of that 
command.  Doing the same with a toolbar button (don’t release the mouse 
button) will achieve a similar result. 
When an entry form or dialog box is displayed, pressing F1 will also 
display help for that section of the program. 

 



TUTORIALS - Introduction 
 
Working on the principle that the first steps into unknown territory are 
always the most worrisome, the following Tutorials for the HAZOP 
Manager software are intended to familiarise you with its basic concepts 
and structure, and at the same time introduce you to some of the features 
of the program.  They will not cover every detail and facility available.  
Rather, they are intended to make you confident in your ability to use the 
program, so that you may continue the exploration on your own. 
It is assumed that you have a basic appreciation of how a Hazop Review 
is conducted, and the general format and requirements for recording the 
results of such a study.  If this is not the case, then you should consult 
beforehand one of the many books and articles on the subject.  That is not 
to say that you will be completely bewildered without such prior 
understanding… indeed, the following exercises may serve to shed some 
light on the subject.  However, in such circumstances there may well be 
times during these tutorials that the meaning of a term or the purpose of 
an instruction may not be completely understandable.  If this happens, 
visit the Help system by pressing F1.  If the text displayed does not 
explain what you need to know, try the Index or Search facilities.  Bear in 
mind, however, that the Help system is primarily aimed at guiding you in 
the use of the program, not teaching you the general methodology of 
Hazop Studies. 
During the course of these tutorials we will employ sample data files 
named EXAMPLE1 and ACTRSP.  These will have been installed with 
the program in a DATA sub-directory on your hard disk.  You will later 
make additions and modifications to these files.  Should you wish to start 
again with the files in their original state, copies of them will be found in 
a sub-directory also entitled DATA on the HAZOP Manager Installation 
CD-ROM.  Use Windows Explorer to overwrite the hard disk files with 
those from the CD.  Always do this when you have finished using the 
tutorials, so that any colleague wishing to make use of them in the future 
will not be confused by the changes you have made. 
Should you not have access to the CD-ROM mentioned above, you 
should instead use Windows Explorer to create a “Copy of 
EXAMPLE1.HDF” (select the file, right click, select ‘Copy’, right click 
and select ‘Paste’).  At the end of the tutorials you can then delete the 
original file, and rename the copy ‘EXAMPLE1.HDF”.  Do the same for 
the ACTRSP.HDF file. 

 



TUTORIAL 1: The Sections of a Data File 
 
This tutorial presents the five main sections of a data file; Study Details, 
Keywords and Codes, Entries, Node Headings and finally Action 
Responses.  You will learn how to easily navigate between them.  No 
additions or modifications will be made at this stage. 
 
1. Start the HAZOP Manager program, and wait for the title window to 

be closed. 

2. Position the mouse cursor over the  toolbar button.  Do not click 
the mouse button.  Note the Tooltip that appears explaining that 
this is the Open (File) button.  If you are unfamiliar with tooltips, try 
pausing with the mouse cursor on other toolbar buttons. 

3. Click on the above File Open toolbar button.  A standard File Open 
dialog will be displayed.  Locate and open the EXAMPLE1.HDF 
entry. 

4. The Study Details Form will be displayed.  Scroll the form using the 
mouse and the scroll bar.  You will see that the information entered 
on this form is mostly self-explanatory. 

 

 



5. Try scrolling the form without the mouse, using instead the Ctrl key 
with the Up/Down arrow keys. 

6. Position the form so that the foot of it is displayed, and Press F1.  
Read the text displayed, paying particular attention to the section at 
the end of the Help topic that deals with Action Numbers.  Then 
close the Help system window. 

7. Click on the  toolbar button.  The Keywords Form will be 
displayed. 

 

8. View the information entered within each of the six tabs at the top 
of this form.  Press F1, and read about this section of a data file.  
Note that dependent upon which tab is currently active, the Help 
window will display different topics when activated.  When 
finished, close the Help system window. 

9. Try moving between these two forms (Study Details and Keywords) 
using the keyboard instead of the mouse.  Enter Alt+G (‘Go To’ 
menu), followed by D (for ‘Details’).  Follow this with an Alt+G 
and then K, and we are back on the Keywords Form. 

 



10. Click on the  toolbar button (or Alt+G followed by E).  The 
Entry Form will be displayed, showing the first entry in the file. 

 

11. Press F1 and scan the Worksheet Entry Form help topic displayed.  
When finished, close the Help system window. 

12. So far the forms we have viewed have been maximised.  Click on 
the appropriate button  in the caption bar to make the form the 
normal size for a child window within a frame window.  The main 
program window should remain maximised. 

13. Note that the controls within the entire form have been re-sized, so 
that there is no need to use scroll bars to view hidden sections.  Try 
re-sizing the form by dragging the sides of its window.  Note also, 
that there is a minimum in both the horizontal and vertical planes 
below which the program prevents re-sizing. 

14. Maximise the Entry form again using the appropriate button  on 
the caption bar. 

15. With small screens (especially on notebook computers) the text may 
appear too small to be easily readable.  From the View menu, select 
‘Font Size and Weight’, and experiment with different settings until 
you find a combination that you are happy with. 

 



16. The top two lines on this form show abridged information from the 
Node Heading.  To view the Node Heading in full, either use the 

 button or double click anywhere on the Node Heading 
information at the top of the form.  Press F1, and scan the topic 
displayed.  When finished, close the Help system window and press 
Cancel on the Node Heading Form. 

 

17. Click on the  toolbar button.  The Action Response Form will be 
displayed.  On it will be recorded the response to the recommended 
action from D Matthews, and you will see that this response has 
been reviewed and found to be acceptable. 

 

 



18. Press F1 and scan the Response Entry Form help topic displayed.  
When finished, close the Help system. 

19. At the present time we can view only the Action and Response 

details.  Press the  button to display the entire entry.  Then press 

the  button to display the Node Heading for that entry. 

20. Press the Cancel button, followed by the  toolbar button.  We are 
now back on the response we were viewing.  From this quick series 
of mouse clicks you will see how easy it is to view every detail 
relating to an action without the need to start up extra program 
modules.  (With regard to displaying the Node Heading, even 
though this doesn’t apply to the current response, in some cases you 
may wish to verify that an operating parameter referred to is indeed 
accurate). 

21. Now navigate back to the Study Details section of the data file using 

the  and  toolbar buttons. 
22. Unless you wish to practice further, you may now close the 

EXAMPLE1 file (Alt+F then C).  Should you have had enough for 
one session, you may also close down the program (Alt+F then X).  
Of course, for either or both of these operations you may click on 
the appropriate buttons on the caption bars. 

 
The above exercise will have introduced you to the methods involved in 
moving between various sections of a data file.  At this stage you should 
have learnt that there are five main sectors; Study Details, Keywords and 
Codes, Entries, Node Headings and finally Action Responses.  Having 
read the Help along the way, you will have a grasp of the purpose of each 
section in terms of the data it contains, and how certain sections relate to 
one another.  You should now feel confident that you could find your 
way to any sector of the file. 
If you wish to practice what we have been doing so far, by all means do 
so.  However, do not make any changes to the file at this stage… we will 
commence that in Tutorial 5. 
In the next Tutorial, we will show ways in which you may navigate 
through the information contained within various sections of the file. 
 

 



TUTORIAL 2: Navigating through the Data File 
 
This tutorial will show you some of the many ways that you can navigate 
through and find information held in various sections of the data file.  If 
you are not familiar with the sections of a data file, you can refer to the 
previous tutorial. 
 
1. Start the HAZOP Manager program, and wait for the title window to 

be closed. 

2. Click on the File Open toolbar button .  A standard File Open 
dialog will be displayed.  Locate and open EXAMPLE1.HDF. 

3. Click on the  toolbar button (or Alt+G followed by E).  The 
Entry Form will be displayed, showing the first entry in the file. 

 

4. Use the  and  buttons to page forwards and backwards 
through the entries in the data file.  Then try using the Ctrl+PgDn 
and Ctrl+PgUp keys to achieve the same result.  As you page 
through the file, note that from time to time the Node Heading 
information at the top will change.  In other words, each Node 
contains many entries. 

5. Page backwards until you are on the first entry again. 

 



EXAMPLE1 is a relatively small data file.  Getting to a specified position 
within this file by paging through entry-by-entry is tedious enough… 
imagine what it would be like with a much larger file.  With this in mind, 
we will explore quicker means of traversing through entries. 

6. Click on the  button.  Either enter 3.0 in ‘Destination Node?’ 
box of the dialog as illustrated below, or select that Node from the 
displayed list.  Press OK, and you will see that we have immediately 
jumped to the first entry in Node 3.0.  Note that, as described in the 
guidance text, we can also jump to a particular keyword or keyword 
combination section within the destination Node. 

 

7. Click on the  button.  Use the Previous and Next buttons on the 
Heading Form displayed to move from heading to heading.  Display 
the heading for Node 1.0, and press OK.  We are back on the first 
entry again. 

8. Click on the  button (or Alt+R then F), enter 23 in the Entry 
Number field of the displayed dialog and press OK.  We are now 
viewing Entry 23. 

 

 



9. Click on the  button again, and enter 16, but this time in the 
Action Number field of the displayed dialog.  Press OK, and we are 
now viewing the entry containing Action 16. 

R10. Use the ‘ ecord’ menu, ‘Find Action or Entry’ option, to go to 
Action 8. 

11. View the Response for this Action by clicking the  toolbar 
button.  The Response for Action 8 will be displayed. 

 

12. In the Response form you may use many of the same techniques for 
navigation that you have already used when viewing the Entries 
form.  The only difference is that you will be navigating through 
Actions and their Responses rather than individual Entries.  Try it…  

use the  and  buttons to page backwards and forwards 
through the Action Responses. 

13. Now, select ‘Find Action’ from the ‘Record’ menu (Alt+R then F) 

or press the  toolbar button.  In the dialog displayed type 23, and 
press OK. 

14. As you will have discovered, there is no such Action number.  Press 
Cancel, or change the 23 to 16 and press OK. 

15. Make a mental note of the way in which the date is displayed in the 
small box entitled ‘DATED:’.  We will experiment with date 
formats in a later exercise. 

 



16. Unless you wish to practice further, you may now close the 
EXAMPLE1 file (Alt+F then C).  Should you have had enough for 
one session, you may also close down the program (Alt+F then X).  
Of course, for either or both of these operations you may click on 
the appropriate buttons on the caption bars. 

 
This exercise will have introduced you to the methods involved in 
navigating through information held within certain sections of a data file.  
At this stage you should feel reasonably confident about opening and 
viewing such a file, knowing with a fair degree of certainty what to 
expect when you press one of the toolbar buttons or invoke one of the 
menu options that we have used. 
If you wish to practice what we have been doing so far, by all means do 
so.  However, do not make any changes to the file at this stage… we will 
commence that in Tutorial 5. 
 

 



TUTORIAL 3: Displaying Additional Data 
 
On some of the forms that we have seen in the previous two tutorials 
there have been fields or entry boxes that do not always need to be 
displayed.  Conversely, there is also data stored within the file that is by 
default not displayed in full, and to view such data we need to take 
positive action.  This tutorial will show you how to display and hide data 
that might, or might not, be necessary for a particular study. 
 
1. Start the HAZOP Manager program, open the EXAMPLE1.HDF 

file and go to the Entries form.  Navigate to Entry 3.  You should 
now be viewing the entry shown below. 

 

2. Notice that, beneath the blue (Entry Number) 3 on the left of the 
form, there is a field displaying the text “N(P)--”.  This indicates 
that a NOTE has been attached to this entry.  To view the note, 
double click the blue text or select ‘Note’ from the ‘Record’ menu. 

 

 



In the dialog displayed, you will notice three tabs.  The first tab 
stores a general note for the current entry.  The second and third tabs 
are initially ‘free’, which is to say that they may store any type of 
information you require.  In the case above, the second tab has been 
labelled ‘SIL Analysis’.  In a later tutorial, we will show how it is 
possible to define your own headings for this and many other forms. 

3. Whilst the Notes dialog is displayed, press F1 for an explanation of 
this facility.  Close the Help window, and press the OK button to 
close the Notes dialog. 

V4. Using the ‘ iew’ menu, experiment with toggling the display of 
Frequency, Severity, Category and Extra Column.  Use the Help 
system to view explanations of these entry points (Hint: you could 
try hovering the mouse over each menu command and pressing F1). 

5. When you have finished reading about these data entry points, 
ensure that the display of all four is toggled on.  If presently hidden, 
press as necessary Alt+V followed by F, Alt+V then C, Alt+V 
followed by S, and finally Alt+V then X.  Note that the program 
stores these settings within EXAMPLE1, so that when we next open 
this data file our choices will be preserved. 

6. Navigate to Action 8, and click the  toolbar button to show the 
response. 

 

 



7. Note that at the foot of the form the estimated cost of the action has 
been entered.  Press F1 to display the Response Form help topic.  In 
the last paragraph there is a hypertext link entitled View Impact.  
Click on this, read the topic displayed, then close the Help window. 

8. You will have read that the default is not to display these Cost and 
Schedule entry points, unless you have specifically asked for this 
information to be supplied.  For the EXAMPLE1 file, this default 
has been overridden. 

9. Try toggling off the display of these entry points (Alt+V then I), 
then showing them again. 

10. Unless you wish to practice further, you may now close the 
EXAMPLE1 file (Alt+F then C).  Should you have had enough for 
one session, you may also close down the program (Alt+F then X).  
Of course, for either or both of these operations you may click on 
the appropriate buttons on the caption bars. 

 
The above exercise will have introduced you to some of the data that it is 
not always necessary to view, and shown you how to hide and display it 
as you may require.  Having completed the first three tutorials, you will 
now be feeling confident enough to navigate through and view all of the 
information in a data file.  In the next two tutorials, we will learn how to 
set program and file defaults, and then start making basic entries. 
If you wish to practice what we have been doing so far, by all means do 
so.  However, do not make any changes to the file at this stage… we will 
commence that in Tutorial 5. 
 
 

 



TUTORIAL 4: Setting Program Defaults 
 
In this exercise we will experiment with setting some program defaults. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close. 
S2. From the ‘ et Defaults’ menu, choose the ‘Date Format’ option. 

 

3. The combo box displayed shows the date formats available, with the 
currently selected one being highlighted.  Solely for the purpose of 
experimentation, make a note of the default format, then change it 
and press OK. 

S4. From the ‘ et Defaults’ menu, choose the ‘Headings File’ option.  
The combo box displayed lists various language files… English, 
German, Dutch, French, Italian and Spanish.  Press F1 to invoke the 
Help system and scan the topic displayed.  Close the Help window. 

 

5. According to the country in which you are located, change if 
necessary the default language, and press OK. 

S6. From the ‘ et Defaults’ menu, choose the ‘Main Spelling 
Dictionary’ option.  The combo box displayed lists dictionaries for 
various languages… English, American, German, Dutch and French 
(whichever are installed).  Press F1 to invoke the Help system and 
scan the topic displayed.  Close the Help window. 

 



 
7. According to the language in which studies are to be recorded, 

change if necessary the default dictionary file, and press OK. 
S8. From the ‘ et Defaults’ menu, choose the ‘Brainstorm Causes’ 

option.  Press F1 to invoke the Help system and scan the topic 
displayed and also the link that describes the method of 
Brainstorming Causes.  Close the Help system and Cancel the 
Brainstorm Causes dialog. 

 

9. From the ‘Utilities’ menu select the ‘Edit Macro File’ command.  
Open the EXAMPLE1.MAC file. 

10. The Text Macro dialog displayed will contain three tabs.  Click on 
each to display the phrases contained under each tab. 

 

 



11. Whilst the Macro dialog is displayed, press F1.  Scan the topic, 
paying particular attention to the discussion regarding the various 
ways in which the phrases may be automatically entered into your 
data file. 

12. When finished, close the Help system window, and then press the 
Close button on the dialog.  Note that by ‘editing’ this macro file we 
have effectively loaded it into memory ready for use.  To make these 
phrases available without editing, we would use instead the 
‘Utilities’ menu ‘Load Macros’ command. 

13. Now open the EXAMPLE1 data file.  However, on this occasion 
don’t use the File Open command as we have previously done.  
Instead, press the Alt+F keys and then stop.  Note the listing of the 
file in the popup menu with a 1 against it.  Press 1 and our file is 
opened without the need to select it from a standard File Open 
dialog.  This file list will always contain the last four files that you 
have worked with, and it is the easiest way to open a data file. 

14. Go to the Entries form by using the  toolbar button. 
F15. From the ‘ ile’ menu select the ‘Change Headings’ option.  The 

combo box displayed is the same as the one we saw in Step 4 above.  
Select the GERMAN.HDS file, press OK, and view the result. 

16. Open the combo box again (Alt+F then H) and then press F1.  Read 
the topic displayed.  On the last line use the hypertext link to the 
Customized Headings File topic to scan that as well.  When 
finished, close the Help system window. 

17. Select ENGLISH.HDS from the list and press OK. 
18. Note that the date in the ‘Respond By’ field (bottom right hand 

corner of the Entries window) is now displayed in the format you 
chose in Step 3 of this exercise. 

19. Now close the EXAMPLE1 file and reset the Date Format (Alt+S 
then D) to its original value. 

20. Unless you wish to continue experimenting with Defaults, you may 
close down the program. 

 
The above exercise will have shown you how to set some basic program 
defaults, and you will have seen the effect of changing Headings and 
Date Formats.  In the next tutorial we will start entering new data into the 
file. 

 



TUTORIAL 5: Adding Entries / Multiple Actions / Renumbering 
 
In this exercise, we will be creating new entries in our data file 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close. 
2. Open the EXAMPLE1 data file; go to the Entries form by using the 

 toolbar button; then jump to Node 3.0 using the  toolbar 
button. 

E3. From the ‘ dit’ menu, choose ‘Load Macros’ and open 
Example1.mac.  In order to use text macros, you don’t have to view 
the Macros window, but should you want to, you can do so by 

pressing the  button. 

4. We will now add an entry to Node 3.0.  Press the  too r button.  
This is the one with the turquoise (blue) plus sign.  Note the 
difference and the placement of this button compared to that 
containing the yellow plus sign.  The button with the turquoise sign 
is grouped with those for Previous and Next entry, whereas the one 
with the yellow plus sign (for adding a new Node Heading) is 
grouped with those relating to moving from Node to Node. 

lba

5. The Primary Keywords dialog will be displayed.  Before we actually 
select a keyword, experiment with the various means by which this 
can be achieved.  Type the letter ‘p’, followed by ‘l’ and then ‘d’ (if 
two keywords begin with the same letter, typing that letter twice will 
highlight the second one).  Then try typing ‘01’, followed by ‘05’.  
At any stage during these key operations we could have pressed 
<Enter> to transfer the word into the DEVIATION column.   

6. The final method of selecting a keyword is by the use of the mouse.  
Double click on the word ‘Isolate’. 

7. The Secondary Keywords will be displayed.  You will note that 
most keywords are displayed in a red font.  Press F1, select the 
hypertext link for Add Entry, and towards the middle of that topic 
page you will see another hypertext link entitled Defining relevant 
Keywords.  Click on that link to read an explanation of why, and 
how, such combinations may be defined.  When finished, close the 
Help window and select the ‘No’ keyword. 

 



8. Type in the CAUSE column “Spectacle blinds fitted upstream of 
pump suction isolation valves”. 

9. In the FREQUENCY box, enter ‘3’ or right-click and choose ‘3 – 
Once per year’ from the list that is displayed (note the tooltips that 
appear if you pause the mouse over either this input box or its 
descriptor) 

 

10. Type in the CONSEQUENCE column “Unable to swing blinds for 
maintenance of standby pump without shutting down system”. 

11. In the first CATGRY box input a ‘3’, and in the first SEVRTY box 
input a ‘1’.  This indicates that the consequences entail an 
Appreciable Production Loss.  Alternatively, right-click in either 
box to show the Severity Matrix (press F1 at this point for guidance 
on how to use the Severity Matrix), double-click the cell that 
indicates Appreciable Production Loss (‘Up to half a day’) and press 
OK. 

 

12. Tab across to the ACTION column, and type “Relocate spectacle 
blinds inboard of pump isolation valves”. 

 



13. Tab to the ASSIGNED TO column. Then press Shift+Alt+4 (all 
three keys together). 

14. The name “D Matthews - XYZ Process Systems” will have been 
automatically typed into our ASSIGNED TO box.  Tab forward to 
the RESPOND BY entry point, and type, in the indicated format, the 
date 20 FEB 2004 (all in digits if necessary). 

 

15. We have now completed our first entry.  Make a mental note of the 
Entry Number (it should be 60)… we will need that number in Step 
18 below.  Page forward once to the next entry in the data file.  This 
will state that no potential isolation problems were identified, which 
is now incorrect.  We need to change the ‘Isolate All’ keywords to 
‘Isolate Remainder’. 

16. There are two methods for altering keywords on an entry that has 
already been recorded.  Firstly you may use Alt+R then K.  Try this, 
and then immediately press the Cancel button.  Secondly, you may 
double click in the DEVIATION column.  Do so, and the same 
dialog that was displayed a moment ago appears again. 

17. We want to retain the word Isolate, so press OK.  Then select 
‘Remainder’ and press OK again. 

 



18. Now purely to illustrate two facilities that may well be of use in 
your studies, type a new sentence in the CAUSE column “See Entry 
60.”  Highlight the number 60, then select from the ‘Edit’ menu the 
option ‘Mark reference…’ ‘…to Entry number’.  After pressing OK 
on the explanatory dialog displayed, the end result should be “See 
Entry 60™°”. 

19. We will need to return to this entry later in the tutorial.  Set a 

bookmark for it by pressing the  toolbar button (or enter Alt+E 
then B).  Accept the default description of “NODE 3.0, Isolate 
Remainder”, and press OK. 

20. The next entry we make will be a multiple action entry.  Before we 
do, press F1, click on the Help Topics button, and use the Index to 
locate the Multiple Actions topic.  Read this topic to gain an 
understanding about when and how you would create such entries, 
then close the Help window. 

21. Press the  button (or Alt+R then A), and select ‘Flow’ followed 
by ‘Less’. 

22. Type in the CAUSE column “Discharge filter partially blinded” and 
allocate the Frequency code 2 (likely to occur approximately every 
ten years).  Under CONSEQUENCE type “Inadequate lubrication 
results in compressor damage”. 

23. Because this consequence will result in both Major Equipment 
Damage as well as Major Production Loss, we want to create two 
pairs of CATGRY/SEVRTY codes.  Right-click in any of the 
CATGRY or SEVRTY boxes to show the Severity Matrix. 

 

 



24. Double-click the cell corresponding to Major Equipment Damage 
such that ‘**1**’ appears in the cell.  Next, double-click the cell 
corresponding to Major Production Loss such that ‘**2**’ appears 
in the cell.  Now, click OK. 

25. Page back one entry.  Note that from Isolate we are now 
automatically in the Flow Less section of Node 3.0.  Copy on to the 
clipboard all the text in the SAFEGUARDS column, which should 
commence “TAH-5925 alarm …”.  Page forward again to our 
incomplete entry, and paste that text into the SAFEGUARDS 
column.  To the last item add the text “… flow, but with a common 
filter this would be ineffective”. 

26. In the ACTION column type “[1] Provide separate filters in the 
discharge of both pumps, each fitted with a dP indicator and local 
alarm”.  Then on the next line type “[2]” followed by a space.  From 
our Text Macro file invoke the macro “Include in operating 
procedures”, and finish off by adding “the action to take upon 
initiation of such an alarm” (the macro can be invoked by pressing 
Alt+5). 

27. Tab forward, and notice that we now stop on the [REF] entry 
position.  Type ‘1’, and allocate this action to D Matthews (using 
our macros, Shift+Alt+4), with a RESPOND BY date of 20 FEB 
2004.  The completed entry should appear as follows: 

 

 



28. Now from the ‘Record’ menu select the ‘Extra Action’ command 
(Alt+R then X).  Type ‘2’ in the [REF] box, and allocate this second 
action to “A Temple - Operations” (macro Shift+Alt+3), with a 
RESPOND BY date of 19 MAR 2004. 

29. Press the  toolbar button, and the dialog illustrated below will be 
displayed.  This facility allows you review (but not edit) multiple 
entries within a Node by scrolling them vertically.  Press F1 to 
display the relevant Help topic, which lists some of the situations in 
which you will find this feature useful.  Close the Help window. 

 
30. Using the scroll bar in the left-hand pane, display the first entry in 

the Node, and then highlight it by clicking on it with the mouse.  
Note the Action Number in the right-hand pane… it should be 14. 

31. Using the ‘down’ arrow key (on your keyboard), highlight each of 
the remaining entries in turn, noting the Action numbers as they are 
displayed.  The sequence should be 14, 15, 22, 23, 16, 17, and 
finally 21.  Close the dialog by pressing the Cancel button. 

32. From the ‘Help’ menu select the ‘Help Topics’ command, and using 
the Index, locate the Renumber - Actions topic.  Read the text 
displayed, then close the Help system. 

33. We will now re-order the Action Number sequence.  From the 
‘Utilities’ menu select ‘Renumber…’ then select the ‘…Actions’ 
command.  Respond Yes to the message regarding a back-up file.  In 
the dialog displayed, accept the default value of ‘1’ and press 

 



‘Renumber’.  Page through the entries in Node 3.0 again, and you 
will see that the Action Numbers are now in sequence. 

34. Repeat Steps 29 to 31, but on this occasion pay attention to the 
Entry Numbers.  They are also out of sequence.  To correct this, 
from the ‘Utilities’ menu select ‘Renumber…’ then select the 
‘…Entries’ command.  Respond Yes to the message regarding a 
back-up file.  In the dialog displayed, accept the default value of ‘1’ 
and press ‘Renumber’.  Page through the entries in Node 3.0 again, 
and you will see that the Entry Numbers are now in sequence. 

35. You should now be on Entry number 47, the last entry in Node 3.0 

(if not, use the  button to jump to that entry). 
36. You will remember that we referenced Entry 60 in Step 18, and set a 

bookmark in our file in Step 19.  Return to that bookmark using the 

 toolbar button.  Highlight “Node 3.0, Isolate Remainder” and 
press OK.  You will see that the reference has been automatically 
updated to the number ‘44’, and you can verify the accuracy of this 
by paging back once to the previously referenced entry that we 
created in Steps 4 to 14. 

 
You have now completed the tutorial dealing with basic data entry.  This 
is the part of the program with which you should become most familiar, 
as it is these operations that will need to be carried out during a Study 
meeting. 
If time permits, you should now make some further entries of your own.  
However, before you do, first go to Node 4.0, so that these additional 
entries will be recorded under that Node.  This is important, because the 
next tutorial will assume that Nodes 1.0, 2.0 and 3.0 contain the 
entries as they are at present, with no additional practice entries 
interspersed. 
In addition, you may well have noticed during the previous tutorials that 
when opening the EXAMPLE1 data file, another file entitled ‘DON’T 
INPUT ENTRIES LIKE THIS’ was in the same folder.  Now that you are 
familiar with basic data entry, you should open this latter file and view its 
contents.  As its name suggests, it contains examples of both the 
incorrect, and then the correct, method of recording multiple Causes for 
the same keyword combination (e.g. Flow No).  As this file is provided 
purely for the purpose of illustrating certain important concepts, you 
should not alter or experiment with its contents. 

 



TUTORIAL 6: Find/Replace and Data File Analysis  
 
This tutorial consists of two simple exercises in finding and replacing 
text, followed by selecting records from the EXAMPLE1 data file and 
printing an analysis tabulation.  You should, if possible, ensure that your 
computer is connected to a printer. 
 
1. If necessary, start the HAZOP Manager program and open the 

EXAMPLE1 data file.  Go to the Entries form by using the  
toolbar button.  Ensure that you are on the first entry in the file (if 
the file has just been opened, you will be positioned on the first 
entry). 

2. We will now undertake a very simple exercise in finding (and 
replacing) text within our data file.  Assume that at the end of the 
study meeting our attention is belatedly drawn to the fact that the 
name ‘A Temple’, which we have been inputting into the 
‘ASSIGNED TO’ box, should in fact be ‘A Templar’.  Rather than 
paging through the entire file to find and correct each error, we will 
use the ‘Find text’ facility to speed up this operation. 

3. Click on the  toolbar button (or input Alt+E then F).  The ‘Find - 
Example1.hdf’ dialog will be displayed.  In the ‘Find what’ edit 
box, input ‘Temple’ (without the quotes). 

 

4. Click on the ‘Find Next’ button, and the first occurrence of the name 
will be highlighted. 

5. Manually edit ‘Temple’ to ‘Templar’.  Then highlight the edited 
name and press Ctrl+C to copy it to the clipboard (ensure that only 
the name is highlighted, not including the space before and/or after). 

Instead of Ctrl+C we could instead use the  toolbar button. 
6. Now press the ‘Find Next’ button again, and automatically insert the 

correct name by immediately pressing Ctrl+V or using the  
toolbar button.  Repeat this operation until you get the message 

 



“Searched to last entry”.  Then press the Cancel button on the Find 
dialog. 

7. In the above short exercise we have simply corrected a series of 
errors in our data file.  We now turn to a potentially much more 
useful and powerful facility, that of analysing the data within that 
file. 

8. Input Alt+A, then S.  The ‘Select Entries’ dialog is displayed. 
9. Drop down the ‘Field’ list box and select the ‘Response’ entry 

towards the end of the list.  Similarly select the ‘contains’ entry from 
the ‘Operator’ list box.  Finally select the ‘notext’ option.  The result 
should appear as illustrated below. 

 

10. From the description of ‘Special Criteria’ given on the dialog, you 
will see that we are selecting all entries for which a Response has 
not been received.  Press the OK button on the ‘Select Entries’ 
dialog.  The program will advise you that six entries have been 
selected.  You will note that the entry screen also turns to green.  
This indicates we are now dealing with a sub-set of our data file (i.e. 
only the six entries selected). 

11. If you page through to the last three of those six entries, you will see 
that they are the ones we created in Tutorial 5. 

12. We now wish to produce a report listing those six entries.  From the 
‘Analyse’ menu, choose the ‘Print selection’ option.  In the list box 
displayed, highlight both the ‘Action’ and ‘Action number, person, 
and date for response’ entries.  Press OK. 

13. In the Print Option dialog that is displayed, select a printer font if 
necessary (this will only be required if the message ‘Please select’ is 
displayed against the Current Printer Font section). 

14. Before printing, we wish to preview our report.  Tick the ‘2-Print 
Preview’ option on the Print dialog, and then press OK. 

 



15. Depending upon the font selected, there is likely to be only one 
report page to preview.  Use the ‘Zoom In’ button and the scroll 
bars to get a closer view.  Then press the ‘Close’ button to return to 
our data file. 

16. If your computer is attached to a printer, you may if you wish print 
that one page analysis report.  Repeat Step 12, but ensure that the 
Print Preview option is unchecked.  Then press OK to send the 
report to the printer.  In a real action follow-up situation you may 
wish to use this report, or a similar tabulation, to contact those 
persons involved to remind them that they need to return their 
responses. 

17. Finally, restore access to your full data file by selecting the 
‘Analyse’ menu, and then the ‘Undo all selections’ option.  You can 
now page through the entire file rather than just the six selected 
entries, and the screen reverts to its normal background colour. 

18. In the steps above you have employed the analysis facility within the 
program in a somewhat contrived situation.  This facility is 
potentially so useful that it might be as well to spend a short time 
becoming more familiar with its features. 

19. Display the Help Topics (Alt+H then H), and using the Search tab, 
locate all topics containing the word ‘Analysing’.  Go to the topic 
entitled ‘Analysing your Data file’ paying particular attention to the 
section at the foot of the page entitled ‘Potential uses’, using the 
hypertext jumps and the ‘Back’ button as necessary.  You should 
also visit the ‘Exporting Analysis Data’ topic. 

 
The above short analysis exercise has served as an introduction to this 
feature of the program.  As mentioned, it has been somewhat contrived, 
as the EXAMPLE1 file is relatively small.  In addition, this file contains 
data applicable to a late stage in a Hazop Study, when many responses 
have been received and a series of review meetings carried out. 
Notwithstanding the above limitations, you should now feel reasonably 
confident in your ability to extract information and operate upon a sub-set 
of your data file.  You may, of course, conduct further exercises of your 
own to experiment with different Fields, Operators, and Criteria.  
However, the point to bear in mind is that this facility, which is so simple 
to use, can significantly ease the burden of controlling action follow-up 
and reporting. 

 



TUTORIAL 7: Printing Reports 
 
In this exercise you will print the type of reports that need to be produced 
at the end of a study meeting.  If possible, you should ensure that a printer 
is attached to your computer. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close.  Open the EXAMPLE1 data file. 
F2. From the ‘ ile’ menu, select ‘Print Minutes (Worksheets)’. 

3. The ‘Print Options - Minutes (Worksheets)’ dialog will be 
displayed.  Press F1 to display the help topic that will explain the 
function of the various options contained within this dialog.  When 
you have finished reading the displayed topic, close the Help 
window. 

 

4. Select the printer font if necessary.  Select the ‘Header’ option; if a 
message is displayed stating “Incomplete Header details …”, press 
the ‘Edit Header’ button, input your company’s name in the 
displayed dialog, and press OK.  Select the ‘Page Numbers’ option.  
Other selections in the Printer and Print Options groups can be left 
in their default state. 

5. We will initially preview our entire report.  Check the ‘2-Print 
Preview’ option, and then press OK. 

 



6. In the preview window use the ‘Zoom In’, ‘Next Page’ and ‘Prev 
Page’ buttons to scan our report.  When finished, press the ‘Close’ 
button to return to our data file. 

7. If Microsoft Word is installed on your computer, you may export 
the report you have just previewed to a Word document.  Otherwise, 
continue at Step 13. 

F8. From the ‘ ile’ menu, choose ‘Print Minutes (Worksheets)’ again. 
N9. In the print options dialog, select the ‘Page umbers’ option. 

10. Drop down the ‘Print to’ list box, and select the ‘Word (automated)’ 
entry.  Press the OK button. 

11. Microsoft Word will be started, and you will be able to watch as the 
data in your file is transferred to a new document.  When the 
operation has been completed, you may page through this document 
in the normal manner.  In an actual study situation, such a file could 
be made read-only (i.e. password protected) and then either posted 
onto your network or e-mailed to interested parties. 

12. Close Microsoft Word.  You may save the Word document if you 
wish to scan it again when you have finished this tutorial.  (For more 
information on exporting reports to Microsoft Word, you should 
read the Help topics ‘Automatically Creating Reports in Microsoft 
Word’ and ‘Exporting Reports to Microsoft Word’.) 

13. If a printer is attached to your computer, you may now actually 
print some partial reports.  Otherwise, you will need to utilise the 
Print Preview option instead.  From the ‘File’ menu, select ‘Print 
Minutes (Worksheets)’ again. In the print options dialog, select the 
‘Page Numbers’ option.  However, on this occasion instead of 
accepting the default of 1, enter 12 in the ‘First page number’ box. 

14. You will be printing only Node 3.0, in which you made some entries 
in Tutorial 5.  Click on the ‘Range’ radio button, and type ‘3.0’ 
(without the quotes) in both the ‘From’ and ‘To’ boxes.  Press OK. 

15. Retrieve the report from the printer and scan the pages produced.  
Note the new entries mentioned above, which should have Action 
Numbers 16, 17, and 20.  Note also how multiple actions 16 and 17 
have been printed. 

16. To print the Action Sheets for those new entries, from the ‘File’ 
menu, choose the ‘Print Action Sheets’ command. 

 



17. Select the printer font if necessary.  Leave other options at their 
default, but in the Print Range area of the dialog, click on the 
‘Range’ radio button and type 16 in the ‘From’ box and 17 in the 
‘To’ box as shown below.  Press OK. 

 
18. Select the ‘Print Action Sheets’ option again.  Click the ‘Range’ 

button, and type 20 in both the ‘From’ and ‘To’ boxes.  Press OK. 
19. Retrieve the three Action Sheets from the printer, and scan the 

format of these pages.  In normal circumstances, of course, these 
would be forwarded to the persons concerned. 

20. Using the same procedure as in Step 18 above, print the sheet for 
Action 18. 

21. Action 18 has had a response returned, and this has been recorded in 
the file.  This response has been reviewed, and further action was 
requested.  Note the difference in format between the other sheets 
and that just printed for 18… especially the RESPOND BY box at 
the top of the page, and the provision of a new box for a FURTHER 
RESPONSE. 

 
In this short exercise you have experimented with print previewing, 
exporting a report to Word, and printing one Node and a few Action 
Sheets.  For the most part you have left print options set at their defaults.  
It would be as well, therefore, to explore those other options not 
previously utilised, such as Landscape printing for Worksheets, the 
printing of additional page footer text (‘Add to Footer’ button), and so on. 

 



TUTORIAL 8: Action Response Input and Review 
 
This short exercise will deal with the input of Action Responses, and in 
part mimic the procedure that will be undertaken for response review 
meetings.  As before, you should ensure that a printer is attached to your 
computer; if not, you will need to print preview your Action Sheets 
instead. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close.  Open the EXAMPLE1 data file, and go to the 

Entries form by using the  toolbar button. 
2. You will be inputting responses for Actions 16, 17 and 20 which 

you created in Tutorial 5, and for which you printed Action Sheets 
in Tutorial 7.  Locate, therefore, the entry for Action 16 using the 
‘Find Action or Entry’ command on the ‘Record’ menu (Alt+R then 

F), and then press the  toolbar button to display the Response 
form. 

3. Type the date 16 FEB 2004, followed by the response “A filter will 
be provided in the discharge from each pump as requested.  See 
attached copy of Design Change Schedule, Item 23”. 

 

4. Page forward to the next action (number 17), type the date 08 MAR 
2004, and then the response “Alarm response included in Section 
5.3 of Operating Manual, copy of paragraph enclosed”. 

 



5. Now either page forward to Action 20, or alternatively locate it 

using the  button on the toolbar.  Type the date 19 FEB 2004, 
followed by the response “Drawing amended, A3 copy attached”. 

6. We now have some responses to review.  To prepare ourselves for 
this rather contrived review of only three responses, we need to load 
the appropriate text macro file. 

E7. From the ‘ dit’ menu select the ‘Load Macros’ command, and load 
the REVIEW.MAC file listed in the displayed dialog. 

8. Immediately display the macro file, either with the key combination 

Alt+M, or alternatively by pressing the  toolbar button. 
9. The first two macros will probably commence (unless previously 

altered) with the phrase “REVIEWED 27 APR 2004 etc”.  Alter the 
day of the month in both of these macros to “28”, then press the 
Close button (not the  button on the caption bar… if that button 
is used, the changes made above will not be saved). 

10. Display the response to Action 16.  Position the caret (cursor) on the 
line below the response, which we entered in Step 3 above, and 
auto-type the second macro (press Alt+2).  On the following line 
type “Please report again as soon as the work has been completed” 
(you may use the text macro keys Alt+5).  The result should appear 
as shown in the illustration below. 

 

 



11. Page forward to Action 17, and on the line below the response, 
invoke the first macro (press Alt+1). 

12. Locate Action 20, and do the same as in the previous step. 
13. Our review has resulted in two responses being accepted (Actions 

17 and 20), with a further response being necessary for Action 16.  
We need, therefore, to print a new Action Sheet for 16.  We could, 
of course, do that in the same manner as was employed in Tutorial 7.  
However, if there were many such sheets to print, printing them one 
at a time would be a very cumbersome process.  We will therefore 
adopt a more efficient approach. 

14.  Return to the Entry form using the  toolbar button.  From the 
‘Analyse’ menu choose the ‘Select’ command.  With the Field set to 
‘Response’ and the Operator set to ‘contains’, position the caret in 
the Criterion box and press Alt+1.  Now carefully use the Backspace 
key to delete all the text that follows the year 2004.  The result 
should appear as illustrated below.  Press the OK button. 

 

15. Three entries should have been selected.  Select again (ALT+A, then 
S) with the Field set to ‘Response’, the Operator set to ‘excludes’, 
and this time type the text ‘(*AC*)’ (without the quotes).  Here, we 
are asking for all actions that have not been completed; those that 
have been completed would contain the (*AC*) flag.  Press OK. 

16. Action 16 only should have been selected.  Choose the ‘Print 
Selection’ command from the ‘Analyse’ menu, and check the ‘Print 
Action sheets’ button on the dialog displayed.  Press OK. 

17. The ‘Print Options - Action Sheets’ dialog will be displayed.  Press 
OK. 

 



18. We now have the Action Sheet ready for forwarding to D Matthews.  
Reinstate our full file with the ‘Undo all selections’ command from 
the Analyse menu. 

 
This short tutorial is only an introduction to the subject of action follow-
up.  Further explanation and guidance is given in the Help system, 
particularly in the ‘Action follow-up and Review Meetings’ and the 
‘Review Meetings and Further Actions’ topics.  You should read these to 
gain a more comprehensive understanding of the methods that you can 
adopt. 
 

 



TUTORIAL 9: The Action Response Utility Program 
 
Having learnt how to print and distribute Action Sheets in Tutorial 7, and 
how to manually input and review responses in Tutorial 8, we will now 
explore the methods you can use to distribute actions electronically.  
Before proceeding, read the section in this guide entitled “THE ACTION 
RESPONSE UTILITY PROGRAM”, which will give you some 
background information on the procedures that follow. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close.  Instead of using the EXAMPLE1 data file, 
for this exercise you should open the ACTRSP.HDF data file.  

Then use the  toolbar button to go to the Entries section. 

2. Press the  toolbar button to display the Response section of the 
first entry, which has an action assigned to D Matthews.  You will 
note that it contains the text “(*TTAF*) Transferred to D 
MATTHEWS_1.ACT (23 JAN 2004)”.  This indicates that this 
action has already been transferred to an Action File. 

3. Page forward to the next action, which was assigned to M Anderson.  
There is no text in this response, so this action has not yet been 
output to an Action File.  If you continue to page forward, you will 
note that all of D Matthews’ actions have been dealt with, but files 
still need to be created for the other three persons to whom actions 
were assigned. 

 

 



4. From the ‘File’ menu, select the ‘Create Action Files’ command.  
The ‘Create Action Files’ dialog will be displayed as illustrated on 
the previous page. 

5. In the ‘List of recipients’, highlight ‘A Temple - Operations’.  Then 
press the ‘Create Action File’ button.  

6. A standard Windows File Save As dialog will be displayed.  Type 
‘A Temple_1’ (i.e. the first file for A Temple) in the ‘File name’ 
box, and then press the Save button. 

7. A message will be displayed advising you that seven actions have 
been added to A Temple’s file.  Press the OK button to clear this 
message.  Then repeat Steps 5 and 6 for both L Ingleton and M 
Anderson, naming their files ‘L Ingleton_1’ and ‘M Anderson_1’ 
respectively.  Finally, press the ‘Finished’ button. 

8. We now have four Action Files.  One had already been created, and 
the other three you have just generated.  You will now need to 
switch programs in order to see how the recipients of those files will 
input and return their responses. 

9. On your Taskbar press the Start button, highlight the Programs 
folder, then the HAZOP Manager V6.0 sub-folder, and finally click 
on the ‘Action Response Utility Program’ icon. 

10. If this is the first time this program has been run on your computer, 
a message will be displayed advising you that the program’s Help 
file will be automatically opened, and inviting you to scan its 
contents.  This Help file has been deliberately kept short, and 
hopefully simple to understand, with all topics on a single page.  
You should take the time, either now or at a later date, to read and 
assimilate the information therein. 

11. On the Action Response Utility Program click on the  toolbar 
button, and locate and open the ‘M Anderson_1.act’ file you created 
in Step 7 above (it is almost certainly in the \DATA sub-directory). 

12. Scroll down to the Response section of the displayed Action 2 sheet, 
and type the text “A CCR low pressure alarm will be provided from 
PC-4916.  See attached copy of Design Change Schedule, Item 2”.  
The result should appear as illustrated on the following page. 

 



 

13. From the ‘Response’ menu, select ‘Mark for return to Secretary’.  
The sheet will turn yellow, indicating that the response is ready for 
return. 

14. Page forward once to Action 9, and type, in its response section, the 
text “The requirement for a gas detector is being discussed by Safety 
Department.  No conclusion has yet been reached”.  As before, mark 
this response for return to the Secretary. 

15. Two responses have been input.  Assuming that M Anderson cannot 
reply at this time to the other actions assigned to him, we will now 
create an interim Response File.  From the ‘File’ menu, select the 
‘Create Response File’ option.  In the standard File Save As dialog 
displayed, accept the suggested ‘M Anderson_1a.rsp’ filename and 
press the Save button.  You will be advised that the response file has 
been created, and the relevant Action Sheets will turn to green. 

 



16. If you wish you can now open that Response file to scan its 

contents.  Press the  toolbar button, and in the File Open dialog’s 
‘Files of type’ list box, select ‘Response files (*.rsp)’.  Open your 
file in the normal manner.  When finished, either exit (close) the 
Action Response Utility program, or re-open the Action File ‘M 
Anderson_1.act’.  This is important, because if the ‘M 
Anderson_1a.rsp’ Response File remains open, access to it will be 
denied when later reading it into the main data file in Step 18 below. 

17. Now switch back to the HAZOP Manager program, and from the 
‘File’ menu, select the ‘Read Response File’ option.  Accept the 
advisory message regarding the desirability of having a backup of 
your data file by pressing the Yes button. 

18. From the File Open dialog displayed, select ‘M Anderson_1a.rsp’, 
and press the Open button.  You will be advised when the response 
update has been completed. 

 and (if necessary) the 19. Finally, use the  toolbar buttons to 
visit the response sections of Actions 2 and 9.  You will see that as 
indicated above, the response text has indeed been automatically 
transferred from the Response file to the data file. 

 
From the above exercise you will have gained an appreciation of how 
easy it is to distribute actions electronically, and to update your data file 
with the returned responses.  The potential increase in efficiency for a 
large study would be significant.  However, if you intend to use this 
facility, you must invest the time to understand it fully.  Comprehensive 
instructions are included in both the HAZOP Manager and Action 
Response Utility programs’ Help files. 
Note that if you wish to repeat this exercise, you will need to overwrite 
the ACTRSP.HDF file from the copy located on the installation CD.  
Otherwise, the “(*TTAF*) Transferred to etc…” text within that data file 
will prevent you from creating further Action Files (the ‘List of 
recipients’ box in Step 5 above will be empty). 

 



TUTORIAL 10: Creating a Data File and Multiple Windows 
 
In this tutorial we will experiment with the procedures that would be used 
when setting up a data file prior to the start of a review.  As there would 
initially be a significant amount of typing involved in setting up a new 
study, to reduce this we will be copying and pasting information from 
EXAMPLE1 into our new file.  To achieve this we will have both files 
open at the same time, and while this is not the primary objective of this 
tutorial, it would be as well to get used to this potentially useful facility.  
We will also be printing, so if possible ensure that a printer is attached to 
your computer. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close.  From the ‘File’ menu, select ‘New’ (ALT+F 

then N), or press the  button on the toolbar. 
2. In the ‘Create new Study Data File’ dialog displayed, name the file 

‘NewStudy’, then press the Create button.  The following dialog 
will appear. 

 

3. Press F1 to display Help on these File Options.  Once you have 
finished reading the help topic, close the Help window.  Ensure that 
the options are set as illustrated above, i.e. Detailed Study, Three 
Hazard Categories and an English Headings file, then press OK. 

 



4. We should now be viewing an empty Study Details form.  As 
indicated earlier, we are going to save time by copying some of the 
information from our EXAMPLE1 file.  So, open the EXAMPLE1 
file (without closing down NewStudy.hdf). 

5. We now have two files open, but can only see one at the moment.  
To switch back and forth between the files, click on the appropriate 
file name in the ‘Window’ menu.  To show both files at the same 
time, choose ‘Cascade’ from the ‘Window’ menu. 

6. Both files should now be shown in the main program window.  
Rearrange them as in the illustration below (important… the input 
boxes for both files should never be totally obscured, whichever file 
is currently in the foreground). 

 

7. Highlight the text ‘EXAMPLE HAZOP REPORT’ in the 

EXAMPLE1 file, then copy it either by pressing the  button on 
the toolbar or typing CTRL+C. 

8. Now, place the caret (cursor) in the corresponding field in the 
NewStudy.hdf window and paste the copied text either by pressing 

the  button on the toolbar or typing CTRL+V. 

 



9. We can also move data around using ‘Drag and Drop’.  If you are 
unfamiliar with the technique of dragging and dropping, find the 
‘Drag and Drop editing’ section of the Help file.  Once you have 
read the topic, close the Help window. 

10. Highlight the text ‘ABC Chemicals’ in EXAMPLE1 then drag it to 
the CLIENT: field in our new file (left-click with the mouse on the 
highlighted text, then move the mouse whilst holding the left button 
down).  Don’t release mouse button just yet!  We want to copy, 
rather than move the text, so press CTRL on your keyboard before 
releasing the button (note the ‘+’ sign that appears). 

11. Repeat steps 7 and 8 (or just 10, if you prefer to ‘drag and drop’) for 
each field on the Study Details form until you get to ACTIONS and 
ENTRIES.  Leave these numeric fields as they are. 

12. Maximise the NewStudy file using the  button on its caption bar, 

then go to the Keywords form by using the  toolbar button (or 
Alt+G then K). 

K13. We now see an empty Keywords section.  From the ‘ eywords’ 
menu, choose the ‘Load’ option.  Select the ‘Detailed Study.kys’ 
file, and press OK.  The information on each of the tabs in the 
Keywords section of our file will now have been input 
automatically. 

14. To gain a fuller appreciation of this feature, press the context help 

 toolbar button, and with the help cursor select the ‘Load’ option 
just used.  When you have completed reading the topic, close the 
Help window. 

15. Go to the Entry form.  We will now practice the creation of new 
Node Headings, ready for the ‘forthcoming study’. 

16. Press the  toolbar button (with the yellow plus sign, grouped 
with the other buttons for Node Heading operations). 

17. Type ‘1.0’ in the NODE REF box (without the quotes), and 
‘COMPRESSOR C-58301, SUCTION AND DISCHARGE 
THROUGH SEPARATOR V-58306A/B’ in the ITEM box (also 
without the quotes’). 

 



18. If you like, you can copy the rest of the information from our 
existing Node 1.0 in the EXAMPLE1 data file.  Switch to the 
EXAMPLE1 data file by clicking on that file name in the ‘Window’ 
menu.  Go to Entries and bring up the Heading information for Node 

1.0 (try clicking the  toolbar button). 
19. Copy and paste, as described earlier, data from the Node 1.0 

Heading in EXAMPLE1 to the Node 1.0 heading in our new file 
(use the ‘Window’ menu to switch between the files). 

20. When you have finished, switch back to the EXAMPLE1 data file 
and close it.  Your screen should look like the one illustrated below. 

 

21. Press OK.  You will now have returned to the Entries form and 

should see that the  button on the toolbar is now available.  It 
was previously disabled because we had no Nodes in which to add 
Entries. 

22. To illustrate one final point, create another new Node by selecting 
‘New Heading’ from the ‘Record’ menu (ALT+R then H). 

23. Type 2.0 in the NODE REF box then tab forward through to 
DRAWINGS AND DOCUMENTS and press F9.  Note that the text 
from the heading on which we were located before commencing this 
operation has been repeated. 

 



24. Type any sensible text in both the ITEM and ITEM 
DESCRIPTION, then press OK. 

25. Finally, we will print an Agenda.  By now you should be familiar 
enough with printing operations to accomplish this without any 
detailed instructions (the command can be invoked with Alt+F then 
G).  However, when the ‘Print Options - Agenda’ dialog is 
displayed, you should press F1 and scan the displayed topic. 

 
The subject of planning for a study meeting and setting up a data file is 
described in the ‘Preparing for a Hazop Study’ Help topic.  This outlines 
not only the software operations involved, but also discusses the overall 
requirements such as assembling data, marking up drawings, etc.  If you 
have not previously organised a study, then this topic should prove useful 
in that it will help you to approach the task in a logical and structured 
manner. 
 

 



TUTORIAL 11: Alternative Data File Types / Headings Files 
 
In this tutorial we will be creating a data file suitable for a general Risk 
Assessment study.  As the default headings are unlikely to be suitable for 
such a study, we will instead produce our own customised headings file.  
Whilst we are creating a new type of data file (i.e. different from the 
usual detailed Hazop Study layout), we will also take the opportunity to 
utilise an ‘Alternative Risk Assessment’ method.  The data file we create 
will be used in the next tutorial, so it is important to complete this 
exercise before progressing to the next. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close. 
U2. From the ‘ tilities’ menu, select ‘Edit Headings File’ (ALT+U then 

H). 
3. From the standard dialog displayed, open the ‘English.hds’ file.  A 

window similar to the one below will be displayed. 

 

4. Press F1 to display the Help file, and read the section on Customised 
Headings Files.  Close the Help window, then read the introductory 
text in the ‘English.hds’ file before progressing. 

 



5. Because we don’t wish our modifications to be saved in the default 
headings file, from the ‘File’ menu, choose ‘Save As…” and name 
the file ‘GenRisk1’ (this step is important… do it now, because it 
is easy to forget if perhaps you are later prompted to save when 
closing the file). 

6. Following the introductory text at the beginning of the file are the 
headings themselves.  The first one we need to modify is the 
‘DEVIATION’ heading.  Scroll down the file until you see the word 
DEVIATION followed by a pipe ‘|’ symbol.  Change 
‘DEVIATION’ to ‘AREA FOR CONCERN’ (without the quotes).  
Make sure the pipe symbol is still present. 

7. Immediately below this line is the ‘Deviation’ heading (note the 
difference in type-case).  This also needs to be modified.  Change 
the word ‘Deviation’ to ‘Area for Concern’ (without the quotes).  
Make sure the pipe symbol is still present.  This part of the file 
should appear as shown below: 
… 
Entry Number|  Analysis window 
AREA FOR CONCERN|  Entry window - Print Tables, Analysis 
Area for Concern|  Analysis window 
CAUSE|   Entry window - Print Tables, etc… 
… 

8. Now, locate the heading ‘NODE’ and replace it with ‘PLANT 
SECTION’.  Replace ‘Hazop Node’ with ‘Plant Section’.  Replace 
‘Node Number and Item’ with ‘Plant Section and Item’.  (Hint: Use 
‘Find’ from the ‘Edit’ menu to locate these headings). 

9. Save the modified Headings file using the ‘Save’ option from the 

‘File’ menu, or by pressing the  button on the toolbar.  Then, 
close the headings file. 

10. Now we need to create a new data file that will incorporate the 
modified headings that we have just generated.  From the ‘File’ 

menu, select ‘New’ (ALT+F then N), or press the  button on the 
toolbar. 

11. In the ‘Create new Study Data File’ dialog, name the file 
‘GenRisk1’, then press the Create button.  The ‘New File Options’ 
dialog will be displayed. 

 



 

12. In this dialog, select the ‘Other’ Study Type option, the ‘One Hazard 
Category’ option and, from the Headings File list, select 
GenRisk1.hds.  This operation is illustrated above. 

13. Press F1 to display Help for this dialog, and using the green 
hyperlink, navigate to the ‘Alternative Risk Assessment Methods’ 
topic.  Once you have read this, close the Help system and press OK 
to create the file. 

14. At the top of the Study Details section displayed, type in the title 
‘GENERAL RISK ASSESSMENT REPORT’.  Leave the rest of the 
fields blank to save time. 

15. Go to the Keywords section of the file (ALT+G then K), and load 
the ‘HazId Study.kys’ keywords file (ALT+K then L). 

16. Go to the Entries section of the file (ALT+G then E).  Notice that, 
rather than DEVIATION being the first column, it is now called 
AREA FOR CONCERN.  Similarly, where we used to see the 
heading ‘NODE’, we now see ‘PLANT SECTION’.  This is a result 
of us using our modified headings file.  Notice also that because we 
chose the ‘One Hazard Category’ Risk Assessment method when we 
created the file, Frequencies and Severities appear beneath the 
Consequence, Safeguards and Action columns. 

 



17. Before we can start entering our study data, we must first create at 

least one Node, so press the  button on the toolbar to bring up 
the New Heading form. 

18. In the PLANT SECTION field, type ‘1.0’, in the ITEM field type 
‘CHEMICAL STORAGE AND TRANSFER’, and in the 
DRAWINGS AND DOCUMENTS field type ‘Chemical Storage 
and Transfer P&ID 060-33-T-D0002, Rev 3’.  Press OK to save the 
new heading to the file. 

 
Having selected the ‘Other’ study type option, and having modified and 
loaded the GenRisk1 headings file, in this exercise you have produced a 
data file that is formatted for the recording of a General Risk Assessment.  
Armed with this basic understanding that choosing different file layout 
options and modifying headings files can be used to accommodate a 
range of different reviews, you will now be able to create customised data 
files for differing types of study. 

 



TUTORIAL 12: Resource Files / Alternative Risk Assessment 
 
In this tutorial we will be using a Resource file to help with a General 
Risk Assessment Study.  In addition to this, an alternative risk assessment 
method will be demonstrated.  We will need to use the data file created in 
Tutorial 11, so if you have not yet completed that tutorial, please do so 
before commencing this exercise. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close. 
2. Before we start creating entries, select the ‘Edit Resource File’ 

option from the ‘Utilities’ menu and Open the ‘Risk Assessment.res’ 
file.  Press F1 and read the help topic displayed.  When finished, 
close the Help window and then close ‘Risk Assessment.res’. 

3. Open the GenRisk1.hdf data file and navigate to the Entries form. 
V4. From the ‘ iew’ menu, select ‘Resource File’, and in the standard 

dialog displayed, open ‘Risk Assessment.res’ again. 
5. ‘Risk Assessment.res’ will now appear in a blue window on top of 

the current entry.  Notice also, the new buttons that have been added 

to the right-hand end of the toolbar .  These will be used 
to transfer data from the Resource file to the current entry.  Click 

anywhere on the data file window and press the  button to add a 
new entry. 

6. Press the  button on the toolbar to display the Resource file 
again.  Then, either from the ‘Edit’ menu or by right-clicking with 
the mouse in the Resource file, select the ‘Find’ option. 

7. In the ‘Find’ dialog, type in ‘tools’ (without the quotes) and press 
the ‘Find Next’ button.  Once the word ‘tools’ has been located, 
press Cancel. 

8. We should now be looking at the sentence ‘Provision for safe lifting 
/ lowering of tools’.  To transfer this sentence to the entry, press the 

 toolbar button to select the current paragraph, followed by the 

 toolbar button to transfer the paragraph to the entry.  This 
operation is illustrated on the next page. 

 



 

9. In the CAUSE column, type ‘Requirement for operator to carry 
tools whilst descending and ascending to/from sump’. 

10. In the CONSEQUENCE column, type ‘Potential for operator to fall 
(only one free hand to grip ladder)’. 

11. Tab to the CATGRY field and type ‘1’ to represent Personnel 
Injury. 

12. Tab to the F (Frequency) field, right-click to display Frequency 
Codes and select ‘3 – Once per year’. 

13. Tab to the S (Severity) field and type ‘2’ to represent a Major 
consequence.  Note that the ‘R’ (Risk) value has been automatically 
assessed and input by the program based on the values contained in 
the Risk Matrix (Keywords view).  Remember, that you could have 
right-clicked in either the CATGRY or S field to view the Severity 
Matrix, from which you could have selected your codes. 

14. In the SAFEGUARDS column, type ‘None’. 
15. Because the safeguards neither alter severity nor frequency, 

duplicate the previous Frequency (3) and Severity (2) in the 
appropriate fields below the SAFEGUARDS column. 

16. In the ACTION column, type ‘Fit an intermediate shelf on which 
tools can be placed before ascending / descending ladder’. 

 



17. As this would serve to reduce the frequency of falls by the operator, 
but not the severity of a fall, in the F (Frequency) field below the 
ACTION column, type ‘1’ and in the S (Severity) field below the 
ACTION column, type ‘2’ (as before).  Notice that the risk has been 
recalculated based on the likely benefit of completing the action. 

18. In the ASSIGNED TO field, type ‘A Davies, Mechanical 
Engineering’, and ask that the Action Response be completed by 20 
FEB 2004.  The completed entry should be similar to that which is 
illustrated below. 

 

19. Press the  button to add another record, then press the  button 
on the toolbar to display the Resource file again. 

20. Three paragraphs below the one we just transferred is the following 
sentence ‘Unambiguous provision for isolation of duty / standby 
equipment’.  Put the caret (cursor) anywhere in this sentence and 

press the  toolbar button to select the paragraph followed by the 

 toolbar button to transfer the paragraph to the entry. 
21. In the CAUSE column, type ‘To provide redundancy, both local 

panels can run either the duty or standby pump’. 
22. In the CONSEQUENCE column, type ‘Electrical isolation not 

achieved due to operator misunderstanding.  Potential injury during 
maintenance’. 

 



23. Tab to the CATGRY field and right-click to bring up the Severity 
Matrix.  Double click to select the cell that contains the text ‘Injuries 
or illness requiring hospitalisation’.  Press OK in the Severity 
Matrix so that the Hazard Category and Severity codes can be 
transferred to the entry. 

24. In the F (Frequency) field, right-click to display Frequency Codes 
and select ‘3 – Once per year’. 

25. In the SAFEGUARDS column, type ‘General maintenance 
procedures require verification of electrical isolation’. 

26. The effect of the safeguards is to reduce the frequency of this 
sequence of events, so in the F (Frequency) field below the 
SAFEGUARDS column, type ‘2’ and in the S (Severity) field below 
the SAFEGUARDS column, type ‘2’. 

27. In the ACTION column, type ‘Include in procedures details for 
ensuring electrical isolation of these particular pumps/panels’. 

28. Since this would serve to reduce the frequency of this hazardous 
event, but not the severity, in the F (Frequency) field below the 
ACTION column, type ‘1’ and in the S (Severity) field below the 
ACTION column, type ‘2’ (as before). 

29. In the ASSIGNED TO field, type ‘L Burrows, Operations’, and ask 
that the Action Response be completed by 19 MAR 2004. 

 
In this tutorial we have employed an alternative Risk Assessment method, 
and used a Resource file to prompt input and also to save time in typing 
the ‘Areas for Concern’.  The potential applications for Resource files are 
many.  It is up to you to consider when and how best you can use them.  
You can, of course create your own Resource files either in a plain text 
editor such as Windows Notepad (remembering that it must have the file 
extension “.res”), or preferably in HAZOP Manager’s special utility 
which can be found by selecting ‘New Resource File’ from the ‘Utilities’ 
menu in the HAZOP Manager program’s main window. 

 



TUTORIAL 13: SIL Analysis 
 
In this tutorial we will briefly explore SIL Analysis.  This will involve 
modifying a headings file, looking at a resource file and creating a data 
file, as well as some data entry.  You will need some knowledge of these 
steps, so it would be just as well if you have completed the previous 
tutorials. 
 
1. If necessary, start the HAZOP Manager program, and wait for the 

title window to close. 
U2. From the ‘ tilities’ menu, select ‘Edit Headings File’ (ALT+U then 

H). 
3. From the standard dialog displayed, open the ‘English.hds’ file. 
4. As we don’t want our modifications to be saved in the default 

headings file, from the ‘File’ menu, choose ‘Save As…” and name 
the file ‘SILHeads’. 

5. Find the following headings and modify them with the text indicated 
below: 

Change DEVIATION to HAZARD 
 Deviation to Hazard 
 CAUSE to PROTECTION 
 Cause to Protection 
 CONSEQUENCE to SIL ANALYSIS 
 Consequence to SIL Analysis 
 SAFEGUARDS to COMMENTS 
 Safeguards to Comments 

The section of the file that you have modified should appear as illustrated 
below. 

 

 



6. Save the modified Headings file using the ‘Save’ option from the 

‘File’ menu, or by pressing the  button on the toolbar.  Then, 
close the headings file. 

7. Now, let us look at one of the resource files used during SIL 
Analysis.  From the ‘Utilities’ menu, select ‘Edit Resource File’, and 
choose ‘SIL-C.res’ from the dialog displayed. 

8. You should see a text file containing guidance on how to choose 
Consequence categories during SIL Analysis.  You could edit this 
file to take account of your company’s specific guidelines.  
However, that is not part of this exercise, so simply close the 
‘SIL-C.res’ file. 

9. Create a new data file (CTRL+N) called ‘SIL Analysis1.hdf’. 
10. In the ‘New File Options’ dialog, select the ‘Other’ study type and 

select ‘SILHeads.hds’ (not to be confused with ‘SIL_4.hds’ or 
‘SIL_5.hds’) from the list of available Headings Files.  Press OK to 
create the file. 

11. At the top of the Study Details section displayed, type in the title 
‘SIL ANALYSIS REPORT’.  Leave the rest of the fields blank to 
save time. 

12. Go straight to the Entries section of the file (ALT+G then E).  
Notice the new column headings that have been loaded from our 
SILHeads file. 

13. We don’t need Frequencies, Categories and Severities for this type 
of study, so we should hide them.  To do this, click on the ‘View’ 
menu and uncheck Frequency, Category and Severity. 

14. Before we can start entering our analysis, we must first create a 

Node; so press the  button on the toolbar to bring up the New 
Heading form. 

15. In the NODE field, type ‘1.0’, in the ITEM field type ‘GAS 
CONDITIONING SYSTEMS’, and in the DRAWINGS AND 
DOCUMENTS field type ‘P&ID Glycol Contactor 345-A3-568-RT, 
Rev D’.  Press OK to save the new Node heading to the file. 

16. Press the  button to add a new record.  Then, in the HAZARD 
column, type ‘High pressure gas breakthrough from contactor to 
Regeneration Systems, caused by LCV-456 sticking open’. 

 



17. In the PROTECTION column, type ‘LAL-457, LALL-458’. 

18. Tab to the SIL ANALYSIS column, and either press the  toolbar 
button, or select ‘SIL Analysis’ from the ‘Record’ menu (ALT+R 
then L).  The following dialog will be displayed. 

 

19. Press F1 to view the Help system’s entry about SIL Analysis.  Once 
you have read this topic, close the Help system.  Click on the 
‘Consequence’ dropdown list and select Cc, to represent a 
considerable financial loss. 

20. Occupancy is not relevant in terms of Financial Loss, so choose N/A 
from the Occupancy list. 

21. Tab to the Probability list and select Pa, then select W2 from the 
Demand Rate List. 

22. The SIL is then calculated by the Program and appears in the SIL 
field at the bottom of the dialog.  To transfer this analysis to the 
current entry, press OK. 

23. Now, tab to the comments field and type the following text 
‘Financial Loss assumed as the major concern.  Significant aspect 
would be penalties incurred because of inability to supply’. 

24. Finally, let us assign an Action to ‘F Smith – Control & 
Instrumentation’ to ‘Confirm that the SIF meets the criteria for a SIL 
2 application’.  Ask that she responds by ‘20 FEB 2004’. 

 



25. Your completed entry should appear as illustrated below. 

 
 
By choosing to create our data file with the ‘Other’ Study Type and 
attaching to it our modified headings, we have created a file suitable for 
recording a SIL Analysis.  For an alternative set of suggested headings 
for SIL Analysis, you could refer to the Help system.  You should by now 
have an understanding of the flexibility that modifying headings files can 
provide in terms of the numerous types of study that can be carried out 
using HAZOP Manager software. 
 

 



 

TUTORIALS - Summary 
 
With the series of tutorials in the previous pages you will have used the 
more significant features and facilities within the HAZOP Manager 
program.  More importantly, we trust that you will now be confident 
enough to explore and practice on your own, not only the operations 
already covered, but those which have not even been touched upon. 
During the course of the exercises, on many occasions you will have seen 
menu options that have not so far been used, and perhaps wondered what 
their purpose was and how they actually operated.  Now is the time to 
find out, because it is important to know how you can get the most out of 
the software.  Such information might prove to be extremely useful if, for 
example, in the middle of a study meeting you need to copy a series of 
entries from one Node to another (Utilities - Copy Entry!). 
Remember that there are two sources of Help.  The on-line variety 
provided by the Help system you have already extensively used, and by 
now you should be able to locate any subject covered within that system.  
However, if a search of the Help file does not produce the answer you are 
seeking, you may always telephone, fax or e-mail us with your query.  
We cannot promise that we will always solve the problem.  However, 
experience has shown that sometimes seemingly intractable predicaments 
can be resolved by the application of what could be considered a devious 
and undocumented sequence of operations. 
Finally, do not forget to use Windows Explorer to overwrite the hard disk 
EXAMPLE1.HDF and ACTRSP.HDF files with those from the DATA 
sub-directory on the HAZOP Manager Installation CD-ROM.  If 
necessary, delete also the Action and Response Files created in Tutorial 9.  
In this way any colleague wishing to use the tutorials will not be confused 
by the changes you have made. 
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